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LINK ENGINE MANAGEMENT LTD – LIMITED LIFETIME WARRANTY

All Engine Control Units (ECUs) manufactured or distributed by Link Engine Management Ltd are
subject to the following LIMITED LIFETIME WARRANTIES, and no others.

Link Engine Management Ltd warrants only to the original purchaser of the ECU, for the lifetime of
the ECU, (subject to the limitations set out below), that the ECU shall be free from defects of
materials and workmanship in the manufacturing process. This warranty ceases to apply and does
not apply to ECUs that have not been manufactured or distributed by Link Engine Management Ltd
for a period of greater than one year.

An ECU claimed to be defective must be returned to the place of purchase. Link Engine Management
Ltd, at its sole option, may replace the defective ECU with a comparable new ECU or repair the
defective ECU. 

This limited lifetime warranty is not transferable and does not apply to any ECU not properly installed
or properly used by the purchaser or end user, or to any ECU damaged or impaired by external
forces. The above warranties are the full extent of the warranties available on the ECU. Link Engine
Management Ltd has no liability to the original purchaser or any other person for any loss, injury or
damage to persons or property resulting from the use of the ECU or any failure of or defect in the
ECU whether by general, special, direct, indirect, incidental, consequential, exemplary, punitive, or
any other damages of any kind or nature whatsoever. Link Engine Management Ltd specifically
disclaims and disavows all other warranties, express or implied, including, without limitation, all
warranties of fitness for a particular purpose, warranties of description, warranties of merchantability,
trade usage or warranties of trade usage.

For off-road use only, not intended for highway vehicles. This ECU contains a user-configurable
software programme, which is updated by Link Engine Management Ltd from time to time. The user
must ensure the current correct version of this programme is downloaded from the website of Link
Engine Management Ltd and installed in the ECU prior to use. This limited lifetime warranty does not
apply where the ECU has been installed with the incorrect version of the software programme. The
user is solely responsible for the setup and testing of all user-configurable features. 

Link Engine Management Ltd License Agreement

The software programme in this ECU is licensed not sold. Link Engine Management Ltd grants the
user a license for the programme only in the country where the programme was acquired. No other
rights are granted under this license and the programme may only be used on one machine at a
time. If the programme is transferred a copy of this license and all other documentation must be
transferred at the same time. The license may be terminated by the user at any time. Link Engine
Management Ltd may terminate the licence if the user fails to comply with the terms and conditions
of this license. In either event the copy of the programme must be destroyed.

Product Warranty Statement





5Contents

© 2023  Link Engine Management Ltd

Table of Contents
Part I G4X Plug-In ECU Installation Manual 6

................................................................................................................................... 61 Introduction

.......................................................................................................................................................... 6Safety Notice 

.......................................................................................................................................................... 6Disclaim er  

.......................................................................................................................................................... 6Suppor t Options  

................................................................................................................................... 62 Pre-Instal lation

.......................................................................................................................................................... 7Injector  Im pedance 

......................................................................................................................................................... 7AltezzaLink

................................................................................................................................... 73 Instal lation

.......................................................................................................................................................... 7ECU Handling Procedures  

.......................................................................................................................................................... 7Fitt ing the ECU 

......................................................................................................................................................... 8AltezzaLink

................................................................................................................................... 94 Additional Sensors/Functions

.......................................................................................................................................................... 9MAP Sensor  

......................................................................................................................................................... 9AltezzaLink

.......................................................................................................................................................... 9IAT Sensor  

......................................................................................................................................................... 9AltezzaLink

.......................................................................................................................................................... 9E-Thrott le Output 

......................................................................................................................................................... 10AltezzaLink

.......................................................................................................................................................... 10Expans ion Connector  

................................................................................................................................... 105 PC Tuning

.......................................................................................................................................................... 10Ins talling USB Dr ivers  

.......................................................................................................................................................... 10Ins talling PCLink  Tuning Softw are 

.......................................................................................................................................................... 10Com m unicating With Your  ECU 

................................................................................................................................... 116 Pre-Start Configuration

.......................................................................................................................................................... 11Firm w are Vers ion 

.......................................................................................................................................................... 11Base Configuration 

.......................................................................................................................................................... 11MAP Sensor  Calibration 

.......................................................................................................................................................... 12TPS Calibration 

.......................................................................................................................................................... 12IAT Sensor  Selection 

.......................................................................................................................................................... 12Input and Output Setup 

.......................................................................................................................................................... 13Tr igger  Calibration 

................................................................................................................................... 137 First Time Startup

................................................................................................................................... 158 Pinouts

.......................................................................................................................................................... 15AltezzaLink  

................................................................................................................................... 179 CAN Information

.......................................................................................................................................................... 17AltezzaLink  

................................................................................................................................... 1810 Known Issues

.......................................................................................................................................................... 19AltezzaLink  



Link ECU Online Manual6

© 2023  Link Engine Management Ltd

1 G4X Plug-In ECU Installation Manual

1.1 Introduction

Thank you for purchasing your Link Plug-In Engine Control Unit (ECU), an advanced, fully programmable
microprocessor controlled Engine Management System.
G4X software employs high resolution fuel and ignition tables with configurable load and RPM centres. When
coupled with up to six dimensional fuel and ignition mapping, barometric pressure compensation and intake
air temperature correction this gives an unprecedented level of tuning accuracy. All Link G4X ECUs are in-field
upgradeable, there is no need to return the unit for software updates.
All Link G4X Plug-In Engine Management Systems are designed with flexibility and ease of installation in
mind. Link Plug-In systems are designed to replace the circuit board inside the factory ECU enclosure. This
provides an invisible install that requires minimal modification to vehicle wiring and ECU mounting.
Installing and tuning any after market engine management system is not to be taken lightly. G4X ECUs give
the tuner the control & flexibility that only top after-market engine management systems in the world can
provide. While every effort has been made to keep G4X ECUs as user friendly as possible, it should be
recognised that added features bring added complexity.
The complete setup of your ECU can be divided into two important tasks:
1. This manual covers the installation of your G4X ECU. While it is not strictly essential that this work is

performed by an automotive electrician, the knowledge and tools available to these professionals makes it
highly recommended. Regardless of who does the installation, it is of utmost importance that instructions
provided in this manual are followed exactly throughout the installation.

2. Once the G4X ECU has been installed it will need to be tuned using a laptop computer with PCLink
software. Information on the configuration and tuning of the G4X ECU is detailed in the help section of
PCLink. G4X ECUs are shipped pre-loaded with a base configuration that should be close enough to get
most engines running after a few application specific adjustments have been made. While hearing the
engine running on the new ECU for the first time is always a satisfying feeling, it is important to realise
that the job is not complete. The amount of tuning performed and the experience of the tuner are the two
most important factors in determining how happy you will be with your engine management system.

1.1.1 Safety Notice

Your Link Plug-In ECU is designed to enhance the performance of your vehicle. However in all cases, your
vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on public roads.

WARNING!
Failure to follow all installation and operating instructions may result in damage to

the Link ECU, personal injury, or harm to property.

1.1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring harness
are correct. However due to variations between vehicle models it is the installers responsibility to check wiring
connections BEFORE installing the ECU. Link will not be held responsible for any damage caused by the
incorrect installation of this product.

1.1.3 Support Options

Should any issues arise during installation, the following options exist for technical support:
1. PCLink help, press F1 while running PCLink
2. Contact your nearest Link dealer. A Link dealer list is available on our website.
3. Link website: www.linkecu.com with Online Discussion Forum.
4. Technical Support Email: tech@linkecu.com
The majority of questions received by the technical support team are clearly answered in the manuals. Please
consult the manuals to make sure that your question has not already been answered.

1.2 Pre-Installation

Before installing the Link G4X ECU into the vehicle some pre-installation checks must be performed. 
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1.2.1 Injector Impedance

Injector impedance is important and needs consideration before installing the ECU.

1.2.1.1 AltezzaLink

The G4X AltezzaLink Plug-In ECU is NOT designed to be used directly with low impedance injectors.
All models that this ECU is designed for are fitted with high impedance injectors from factory. This means
that the ECU is plug-in compatible with factory fitted injector combinations on all models. If low impedance
injectors are to be fitted then a ballast resistor pack will be required. Contact your Link dealer for further
information.

1.3 Installation

This guide provides information on correctly and safely installing your new Link G4X Plug-In ECU.

1.3.1 ECU Handling Procedures

WARNING!!!
The following installation process will require handling of both the Link ECU and

factory ECU. Both of these are highly sensitive to electrostatic discharge and are
easily damaged. Follow the anti-static precautions given in this manual carefully

to avoid damaging electronic components. Warranty claims for ECUs damaged by
electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can reach very high
voltages. Whenever given the opportunity this energy will attempt to discharge (usually through

your finger tips!). This can be fatal to most electronic components. Most people have
experienced an electrostatic discharge when they step out of their car or touch a metal bench

top. 
The following guidelines describe precautions that can be taken to reduce the possibility of

damaging your ECU:

1. Work only on a conductive surface. A clean steel bench is suitable.
2. Always wear a wrist strap that is electrically connected to the conductive 

working surface. An Anti-static wrist strap is included for use during install
3. Touch the working surface regularly.
4. Do NOT touch components on the circuit board.
5. Where possible, only handle the ECU by its plastic header.
6. Do NOT carry the ECU around without anti-static packaging. 
7. Do NOT touch the bare terminals in the ECU header.

Observing the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.

1.3.2 Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.



Link ECU Online Manual8

© 2023  Link Engine Management Ltd

1.3.2.1 AltezzaLink

The following steps outline the installation procedure:
1. Remove the factory ECU from the vehicle: Ensure the key is in the OFF position. The factory Altezza ECU

is located in the engine bay on the left side of the vehicle. Remove the plastic cover (3 x 10mm head
bolts) Unplug the wiring harness from the factory ECU. Remove the nuts that retain the ECU mounting
structure and remove the ECU from the vehicle. DO NOT touch the exposed pins in the factory ECU
connector.

2. Remove the factory ECUs circuit board from its enclosure: Ensure you are following the given anti-static
guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP connected to a conductive working
surface. Remove the top cover by removing the screws. Remove the circuit board by removing the screws.
Hold it only by the plastic header and place it aside.

3. Modify the case if required: It may be necessary to file three holes in the edge of the case for the tuning
cable, expansion connector cable, and MAP hose to exit through. Ensure that any modifications are de-
burred to prevent cutting into cable insulation.

4. Connect the ECU USB tuning cable and the expansion loom to the Link Plug-In ECU if required.
5. Fit the Link Plug-In ECU: Place the Link ECU into the case, carefully make sure the ECU is sitting flat in

the case. Refit the top cover and fit the screws as shown in the image below.
6. Place the factory ECU in the packaging your Link ECU came in for protection.

 
7. Fit the ECU back to the vehicle.
8. Connect the ECU to the factory wiring loom.
9. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual first.
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1.4 Additional Sensors/Functions

G4X Plug-In ECUs offer various options for the installation of additional sensors and devices. As a minimum it
is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP) sensor and Intake Air
Temperature (IAT) sensor. These parts can be purchased if required from your nearest Link dealer. 

1.4.1 MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure source after the
throttle body. It is common to 'T' into the fuel pressure regulators pressure signal. Do NOT share this signal
with other devices such as boost gauges or blow off valves.

Note: Internal MAP Sensors on new plug-in ECUs have changed from 4Bar to 7Bar. The 7Bar versions should
be identifiable by a sticker on the bottom board and can also be confirmed by comparing MAP and BAP when
the MAP vacuum line isn't connected to see if they match with the calibration being used.

1.4.1.1 AltezzaLink

The G4X AltezzaLink Plug-In ECU supports several options for fitting of a MAP sensor. Any one of the
following options can be used:
1. Internal MAP Sensor – To ease installation the G4X AltezzaLink ECU is fitted with an internal MAP

sensor. This sensor is either rated to 4.0 Bar absolute pressure (3.0 bar boost) or 7.0 Bar absolute
pressure (6.0 bar boost) depending on the age of the bottom board. Which sensor is fitted can be
ascertained by looking at the sticker on the bottom board (should say 7 Bar for 7 Bar models and nothing
for 4 Bar) or by looking at the MAP value when at atmospheric pressure and changing the calibration
setting. The internal MAP sensor is wired to An Volt 3.

2. MAP Sensor Wired Through AFM – To avoid running additional wires into the engine bay, a MAP signal
can be brought in through either of the AFM signal wires. The AFM signal is wired to An Volt 4. Refer to
factory wiring manuals for AFM wiring connections. Make sure the AFM can not be reconnected.

3. MAP Via Expansion Connector - The expansion connector provides power, ground, and analog channels
for the connection of a MAP sensor.

Make sure that the correct MAP sensor input has been selected in PCLink and a MAP calibration has been
performed before attempting to start the vehicle.

1.4.2 IAT Sensor

It is highly recommended that an IAT sensor be fitted in all applications to provide an input for correction of
fuel and ignition based on the engines air charge temperature.
An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the manifold is not
recommended due to heat soak issues. A fast response sensor must be used in all forced induction
applications.

1.4.2.1 AltezzaLink

The G4X AltezzaLink Plug-In ECU supports the following options for fitting of an IAT sensor:
1. Factory IAT Sensor – Models supported by this ECU are factory fitted with an IAT sensor. The factory IAT

sensor is wired to An Temp 2 and the IAT sensor is built into the AFM (Air Flow Meter). The IAT sensor in
the AFM is wired to pin A16 on the ECU, if the AFM is removed this connection can be used for an
aftermarket IAT sensor.

2. IAT Through Expansion Connector - The expansion connector provides ground and An Temp 4 for the
connection of an IAT sensor. Note spare An Volt channels can be used as temperature inputs when a
pullup resistor (to +5V) is added.

1.4.3 E-Throttle Output
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1.4.3.1 AltezzaLink

This vehicle has E-Throttle from factory.
The E-Throttle Output pins are Aux 9 & 10 and the EThrottle Relay is Aux 7. If the EThrottle is found to be
operating in the wrong direction this can be rectified by changing the Aux 9 Active State (Electronic Throttle -
> E-Throttle 1 -> E-Throttle Setup or by swapping the +ve and -ve pins at the throttle plug.

1.4.4 Expansion Connector

Expansion connectors are provided to allow easy connection of additional ECU inputs. An “expansion cable”
can be purchased from your Link dealer. 
Important points when wiring to the expansion connector:
· Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V out signal also

provides power for other sensors.
· Do not connect the ground pin to chassis ground. This could cause ground loops and introduce

unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

The Expansion connectors available for each ECU can be found under the Pinouts Section.

1.5 PC Tuning

G4X ECUs require PC/laptop tuning using the PCLink Tuning Software application running on a Windows
based computer. PCLink may be downloaded from www.linkecu.com. Note that when new versions of PCLink
are released they are posted on the website and may be downloaded at no cost. Also note that G4X ECUs
must be used with the correct version of PCLink.

IMPORTANT!
The G4X ECU has on board USB.

BEFORE connecting the ECU to your laptop, the USB drivers must be installed.
Failure to install the drivers on your laptop first may result in windows assigning
incorrect drivers. These drivers will not work with the G4X ECU and are difficult to
uninstall. The correct USB drivers are installed as part of PCLink installation, as
described in the following section. Should internet download not be practical, a

copy of the drivers on CD can be obtained from your nearest Link dealer.

1.5.1 Installing USB Drivers

Before connecting the ECU to your laptop or PC, the ECU USB drivers must be installed. These drivers are
installed as part of PCLink installation as described in the following section.

1.5.2 Installing PCLink Tuning Software

Due to the frequent updates PCLink is no longer shipped with each ECU. You will be required to download the
latest version of PCLink from: linkecu.com
Should access to an Internet connection be impractical, download the latest version of PCLink elsewhere to a
USB drive, and then install on your laptop.
Installing from the web
1. Go to the above website and navigate to the downloads and software updates section.
2. Download the latest version of PCLink. When prompted to run or save the file, select save. It is

recommended to save this file on the desktop.
3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes. This may take some time.
5. When installed, open PCLink by double clicking on the icon that has been placed on the desktop.

1.5.3 Communicating With Your ECU

After PCLink installation, you will be able to connect the G4X ECU to the laptop to perform set-up and tuning
work.



G4X Plug-In ECU Instal lation Manual 11

© 2023  Link Engine Management Ltd

1. Connect the ECU to your laptop using a Link G4X ECU USB Cable. If not supplied with the ECU, these
can be purchased from a Link dealer. No other adapter or cabling is required. Connect the cable to the
connector labelled USB.

2. If this is the first time you have connected a G4X USB ECU to your laptop follow the driver installation
instructions that appear. When prompted if you want to install drivers select 'Continue Anyway'.

3. Start PCLink by double clicking on the PCLink icon on the windows desktop.
4. Switch the key to the ON position. This will provide power to the ECU.
5. In PCLink, under the 'Options' menu, select 'Connection'. The connection options dialogue will open.

Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.

6. PCLink offers both mouse and keyboard control. To establish a connection between the PC and ECU
press the F3 key. The same process can be used to disconnect. If a successful connection is
established, PCLink will download settings from the ECU, otherwise you will be warned that an error has
occurred.

7. Make sure the connection shows “ONLINE” in the top right corner of PCLink.
8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning the

ECUs power off all changes made will be lost.

1.6 Pre-Start Configuration

Before starting the vehicle, important pre-start configurations need to be made.

1.6.1 Firmware Version

It is recommended to ensure that the Link G4X ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with PCLink and selecting 'ECU Information'
under the Help menu.
The latest firmware can be downloaded from our website with PCLink. 
It is recommended that this is performed by an experienced Link dealer as new features may need to be
properly configured.
The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in PCLink, follow
the on screen instructions to complete the firmware update process.

1.6.2 Base Configuration

All G4X Plug-In ECUs are shipped with base configuration settings. Note that these are provided to reduce
initial setup and tuning times. They are NOT recommended tuning values. PCLink includes base
configurations for various models. Download the appropriate base configuration into your ECU with PCLink by
connecting to the ECU (described in the Connecting To PCLink section of this manual), then selecting 'Open'
under the 'File' menu. Select the appropriate .pclx file and then select 'Open'. Downloading large configuration
files can take up to a few minutes. Be patient and acknowledge any messages PCLink shows.

1.6.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match the
Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP sensor also
allows the MAP sensor to be calibrated prior to tuning.
Link G4X ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This ensures that all
PCLink Tuning Software programs (pclx Files) give a consistent state of tune throughout the ECU range. This
allows a pclx file to be transferred between G4X based ECUs giving an equivalent state of tune providing all
factors affecting volumetric efficiency are equal.
Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge Pressure
(MGP) as a load index.
To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP sensor.

Select the correct MAP Sensor Type.
3. Under the 'Options' menu, select 'MAP sensor calibration'.
4. Follow the on screen instructions.
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5. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).
7. Perform a 'Store' by pressing F4.

A more in depth explanation is provided in the PCLink help Manual under PCLink G4X Users Manual ->
Tuning Operating Procedures -> ECU Controls -> MAP Sensor Calibration.

1.6.4 TPS Calibration

E-Throttle Vehicles:
The Throttle Position Sensors (TPS Main and Sub) and Accelerator Position Sensors (APS Man and Sub) are
used by the ECU to control the throttle blade position and to calculate various engine management
parameters used by functions such as idle speed control,acceleration enrichment and motor sport features. It
is very important that these inputs are setup correctly and the E-Throttle operation is tuned properly before
starting or driving the vehicle, failure to do so can result in damage to the Throttle body, engine, vehicle and
even the operator and bystanders. The following procedure shows how to calibrate the APS and TPS sensors:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Open Electronic Throttle -> Accelerator Position Sensor and ensure that the APS (Main) Source and APS

(Sub) Source settings are set to the correct inputs. Refer to the Pinouts section of this manual for details.
3. In the same window double-click on 'APS Calibration' and follow the instructions on the screen.
4. Open Electronic Throttle -> E-Throttle 1 -> Throttle Position Sensor and ensure that the TPS (Main)

Source and TPS (Sub) Source settings are set to the correct inputs. Refer to the Pinouts section of this
manual for details.

5. In the same window double-click on 'TPS Calibration' and follow the instructions on the screen.
6. If your vehicle has two E-Throttles then repeat the above two steps for TPS 2(Main) and TPS 2 (Sub) in E-

Throttle 2.
7. Select the 'General' tab in the runtime values section of PCLink (lower part of the screen).
8. Ensure the APS (Main) and APS (Sub) values read 0% when the pedal is released and 100% when fully

depressed.
9. Perform a 'Store' by pressing F4.

1.6.5 IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the intake
system. It is important that the ECU is calibrated to match the sensor installed in the engine. This procedure
is as simple as selecting the correct sensor type as follows:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.
2. Click on 'Analog Channel' in the configuration tree.
3. Select the An Temp channel the sensor has been wired to.
4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.
5. Select the correct 'Temp Sensor Type'.
6. Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
7. Ensure that IAT reads the correct temperature.
8. Perform a 'Store' by pressing F4.

1.6.6 Input and Output Setup

As the Link G4X Plug-In ECUs are designed to run several models there are a few items that must be set-up
to make the ECU specific to your model. 
The Pinouts section of this manual gives a list of the functions of each channel based on the target vehicle.
It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:
All Auxiliary Output Channels 
Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs
Look at the Digital Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.
All Analog Volt and Temperature Inputs
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Look at the Analog Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

1.6.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous sections have been
completed. Only after all pre-start checks have been made should an attempt be made to crank the engine.
The following steps must be performed before an attempt is made to start the engine to ensure the G4X ECU
is calibrated to precisely measure engine position.
1. Connect the ECU to PCLink.
2. Select 'Fuel', then 'Fuel Set-up':

a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.

b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.
3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the PCLink help

(Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the acceleration and
deceleration of the crankshaft at low speeds, an inaccurate measurement of engine timing is usually made.
Also it is often harder to see timing marks with a timing light at slow engine speeds. Trigger calibration should
be checked again at between 2000-4000 RPM where engine speed is stable and a more consistent timing
reading can be obtained.

A more in depth explanation is provided in the PCLink help Manual under G4X ECU Tuning Functions ->
Triggers -> Calibration.

1.7 First Time Startup

For further help on any of the settings discussed below, consult the Help in PCLink Tuning Software. Help
can be invoked by pressing F1, or right clicking any item and selecting ‘What’s this?’.

Pre-set-up Checks
Before attempting to configure the ECU, ensure the following tasks have been completed:
1. Ensure the ECU and all associated components are connected and correctly wired/installed.
2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up

procedure.
3. Check all oil and water levels are correct.

Connecting to PCLink Tuning Software
Use the following procedure to establish a connection between your Link ECU and PCLink Tuning Software
tuning software.
1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to PCLink as described in the 'Communicating with your

ECU' section of this manual. 

First Time Startup
After performing all set-up instructions given in previous sections, including trigger calibration, the engine is
now ready to be started. The following procedure should be used for first time start-up.
1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to PCLink.
3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:

a. TPS – spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration. If the vehicle
has an E-Throttle confirm that APS (Sub), APS (Main), TPS (Sub), TPS (Main) all operate correctly
and that the throttle blade tracks the target correctly.

b. MAP – should read approx 101 kPa (at sea level) with the engine not running. If not, check the MAP
Sensor Type setting and perform a MAP Calibration.

c. ECT – should read current engine temperature.
d. IAT – should read current intake air temperature.
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e. Digital Inputs (click the 'Digital' tab) – Operate switches connected to any digital inputs while watching
the runtime value to ensure they operate as expected.

4. Rectify any faults found in Step 3.
5. Ensure the basic Fuelling setup is correct.

a. If using Traditional Fuel Equation Mode then locate the 'Master Fuel' setting in the ECU Settings Menu
under: Fuel > Fuel Setup > Fuel Main. This will need to be adjusted during or just after start-up.

b. If using one of the Modelled Fuel Equation Modes then navigate to Fuel > Fuel Setup > Fuel main and
enter the correct engine capacity, correct base fuel pressure, and correct fuel properties. Navigate to
>Fuel>Fuel Setup>Injector Setup, enter correct injector flow rate and rated pressure.

6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning.
a. If using Traditional Fuel Equation Mode the Master Fuel settingcan be used to enrich/lean the engine

(increase to enrich).
b. If using one of the Modelled Fuel Equation Modes the Injector Flow Rate can be decreased to add

more fuel, this will need to be changed back to the correct value later but works well for first start
purposes.

7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count one or
two on the first engine revolution.

9. Once the engine starts:
a. If using Traditional Fuel Equation Mode adjust the Master Fuel setting to achieve best possible running
b. If using one of the Modelled Fuel Equation Modes adjust the Injector Flow Rate setting to achieve best

possible running, this will need to be changed back to the correct value later but works well for first
start purposes.

10. The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don’t forget to keep an eye on engine temperature.

11. Once the engine is warmed up and running well, perform another trigger calibration (known “as setting the
base timing”).

12. Perform a Store by pressing F4.

Essential Tuning Adjustments
It is assumed that at this stage all set-up procedures described in previous sections have been completed
and the engine is running. The following steps detail correct set-up procedures for some of the more critical
ECU parameters (note that MAP Sensor Calibration should have already been completed by now):

Injector Voltage (Dead-time) Correction
There is always a delay between the injector being energised and the injector actually opening. Likewise,
there is a small delay between the injector being de-energised and the injector closing. The opening time is
considerably longer than the closing time, however the overall result is that less fuel will flow for a given pulse
width than would be expected with an 'ideal injector'. To compensate for this the injector pulse widths are
increased to compensate for this 'dead-time'. The dead-time for a given injector is a function of the battery
voltage, differential fuel pressure and the type of injector driver (saturated or peak and hold). A typical dead-
time at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms = millisecond = 1 thousandth of a
second). 
In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only variable
that is changing will be the battery voltage (this changes with electrical load and sometimes engine speed).
Without correction, the changes in dead-time will cause the engine to run lean when the voltage drops. If the
Injector Voltage Correction is properly set-up then changes in the battery voltage will not affect the air/fuel
ratio.
The injector dead-time table allows the dead-time for different battery voltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system voltage.
Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine. 
To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set voltage. Vary the supply
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voltage to the injector and measure minimum pulse width at which the injectors will flow for a particular
voltage. This is the required dead-time for that injector at that tested voltage. 
To determine injector dead-time on a running engine, with the engine fully warmed and operating at stable
air/fuel ratios (a very precise AFR meter is required – a narrow band O2 sensor will not suffice), electrical
drain needs to be applied to the system; the preferred method is disconnecting the alternator main fuse.
Battery load testers are also useful here too.
Watching the air fuel ratios change while the battery voltage drops, the dead-time table can be trimmed to
maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth curve
needs to be maintained at all times.
NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.

Traditional Fuel Equation Mode Master Fuel Setting
If using Traditional Fuel Equattion mode the Master Fuel setting should be set so that the numbers in the
middle of the fuel table end up around a value of 50. This is to allow sufficient span of the numbers in the main
fuel table.

1.8 Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire side).

1.8.1 AltezzaLink

Pin ECU Pin Function Pin ECU Pin Function

P1 Injector 1 Injection Q3 nc

P2 Injector 2 Injection Q4 nc

P3 Injector 3 Injection Q5 nc

P4 Injector 4 Injection Q6 nc

P5 Aux 5 Variable Intake Control (ACIS)
(Some models)

Q7 nc

P6 nc (+12V
constant)

Q8 nc

P7 Aux 6 Evaporator purge Q9 nc

P8 Ground Q10 An Volt 7 NB O2 sensor #2 (some
models)

P9 Ground
(Shield)

Q11 Injector 6
(Aux)

O2 sensor #2 heater
(some models)

P10 Ignition 1 Ignition Q12 nc

P11 Ignition 2 Ignition Q13 nc

P12 Ignition 3 Ignition Q14 An Temp 3 Ambient Air Temp

P13 Ignition 4 Ignition Q15 nc

P14 nc Q16 nc

P15 DI 1 Power Steering Switch Q17 nc

P16 An Temp 2 IAT (in Air Flow Meter) Q18 nc

P17 An Temp 1 ECT Q19 DI 3 Vehicle Speed input
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P18 nc Q20 nc

P19 Aux 10 E-throttle motor - Q21 nc

P20 +14V Out EThrottle Clutch +ve Q22 nc

P21 Ground Q23 nc

P22 DI 5 Alternator Input Q24 nc

P23 nc Q25 nc

P24 nc Q26 Aux 3 Tacho Output

P25 nc Q27 DI 6 Brake pedal switch

P26 nc Q28 DI 4 Start signal

P27 Knock 1 Knock

P28 An Volt 1 Narrow band O2 sensor N1 nc (+12v
constant)

P29 Aux 9 E-throttle motor + N2 nc

P30 Aux 7 E-throttle clutch N3 Ignition 5
(Aux)

Fuel pump relay

P31 Ground N4 Ignition 6
(Aux)

Engine fan relay

N5 BEAN
Output

Controlled by CAN2

O1 Ground (AFM) N6 DI 7 AC pressure switch

O2 +5V Out N7 Aux 11 Check Engine light

O3 Injector 5
(Aux)

O2 sensor heater N8 +14V ECU Power

O4 Aux 1 VVT solenoid - Inlet N9 nc

O5 +14V Out VVT solenoid - Inlet N10 Ignition
Switch

Controls Main EFI Relay
(N22)

O6 Aux 2 VVT solenoid - Exhaust N11 An Volt 10

O7 +14V Out VVT solenoid - Exhaust N12 BEAN
Output

Controlled by CAN2

O8 DI 8 AC compressor sensor N13 nc

O9 nc N14 nc

O10 nc N15 Ground

O11 nc N16 +14V ECU Power

O12 nc N17 nc

O13 nc N18 nc

O14 DI 2 VVT position sensor - Exhaust N19 nc

O15 Trig 2 Trig 2 (Intake) N20 nc

O16 Trig 1 Trig 1 (Crank) N21 nc

O17 Ground N22 Main EFI
Relay

Controlled by Ignition
Switch (N10)

O18 Ground
(Signal)

O19 An Volt 2 APS (Sub) On Board
MAP

An Volt 11 MAP

O20 An Volt 3 APS (Main) Expansion
1

Ground
(Signal)
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O21 An Volt 4 Air Flow Meter Expansion
2

+5V Out

O22 An Volt 5 TPS (Sub) Expansion
3

DI 10

O23 An Volt 6 TPS (Main) Expansion
4

DI 9

O24 Ground (Trig
1)

Expansion
5

An Volt 9

Expansion
6

An Volt 8

Q1 Ignition 7
(Aux)

AC Clutch Expansion
7

An Temp 4

Q2 nc Expansion
8

Aux 8

Note: Injector Drives 7 and 8 aren't exposed and don't have the hardware required to drive Injectors.

1.9 CAN Information

The following CAN (Controller Area Network) information is provided:

1.9.1 AltezzaLink

The G4X AltezzaLink ECU contains a CAN to BEAN (Body Electronics Area Network) converter. This allows
the ECU to transmit and receive information with other devices in the vehicle.

Information transmitted by the G4X AltezzaLink ECU:
· Engine Speed
· Engine Coolant Temperature
· Ambient Air Temperature (An Temp 3)
· Fuel Per Cylinder
· Air Conditioning Request
· 'Snow' button (CAN DI 2)
· Alternator Light (DI 5)

Information received by the G4X AltezzaLink ECU:
· Air Conditioning Request (CAN DI 1)
· 'Snow' button (CAN DI 2)

The G4X AltezzaLink ECU uses its 'CAN 2' communication bus to communicate with the other devices in the
vehicle. When first receiving your G4X AltezzaLink ECU the CAN 2 (BEAN) will be set up already. 

Should something change and you need to restore the CAN 2 (BEAN) setup to original, complete the
following steps:

1. Connect your laptop to your ECU with the USB communications cable and turn the ignition to the ON
position.

2. Start PCLink for G4X and press F3 to connect to the ECU. When the ECU is connected the status bar in
the top right corner will be green.

3. Select ECU Controls > CAN Setup.
4. Select the CAN Module 2, set the Mode to 'User Defined' and the Bit Rate to 1 Mbit/s.
5. Now select CAN Channel 1 and configure its mode to 'Transmit User Stream 1', set the ID to 88, the

Format to Standard, and the Transmit Rate to 20 Hz.
6. Next select CAN Channel 2 and configure its mode to 'Receive User Stream 2', set the ID to 89 and the

Format to Standard.
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7. Change to the Streams tab of the CAN Setup window
8. Select Stream 1 and click the 'Load Stream' button. Navigate to your PCLink install directory and select

the CAN sub-directory, choose 'Link G4X Altezza Plug-in Transmit' and click the Open button.
9. Select Stream 2 and click the 'Load Stream' button. Navigate to your PCLink install directory and select

the CAN sub-directory, choose 'Link G4X Altezza Plug-in Receive' and click the Open button.
10. Click the Apply button and then the OK button
11. Press F4 to perform a 'Store' upon your ECU.

The AltezzaLink ECU also has a second CAN bus available for use (CAN 1) that can be used with
aftermarket devices.
CAN bus 1 uses a 5 pin connector and is labeled on the ECU as 'CAN 1/RS232'.
If using this connector for CAN ensure the cable being used doesn't have Serial wires connected as this can
act as an aerial and prevent USB communications from working.

CAN 1/RS232 Connector

Pin Function Colour

1 Comms GND Brown

2 CAN1 L Green

3 CAN1 H White

4 RS232-RX Grey

5 RS232-TX Yellow

1.10 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that have
not been tested. For this reason issues can arise.

WARNING: Always download the latest Installation Manual from linkecu.com and check the latest status of
known issues before installing the ECU.
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Please contact your nearest Link dealer when suspecting a compatibility issue.

1.10.1 AltezzaLink

Current known issues with the Link G4X AltezzaLink Plug-In ECU:
· The Link G4X AltezzaLink ECU does not support traction control, when the ECU is fitted to the vehicle

the TRC light on the dash will flash. The only solution is to remove the bulb. It is worth noting that the
vehicles ABS system will function as per normal.

· The fuel level and instantaneous fuel consumption gauges on the Toyota Altezza facelift model (from
April 2001 onwards) are not supported.
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